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Tobacco Health Document Submission

On June 22, 2009, the President signed the Farnily Smoking Prevention and Tobacco Control Act {Tobacco Control Act) (Public Law 111-31) into
lawr. Arnong its many provisions, the Tobacco Control Act added section 9040a)4) to the Federal Food, Drug, and Cosmetic Act (the act) {21 T.5.C.
§ 387d(a)(4)), requiring subrmission of docutnents related to cettain effects of tobacco products. To wew the Tobacco Control Act, see Public Law

citation (Pub. Law 111-313

Complete the following question and answer form to st your ingredients and subrnit the required data to FDA's Center for Tobacco Products wia the
FDA Electronic Submissions Gateway (ESG). To register with the FDA ESG, go to wownw. fida gow/esg/.

For your reference, see the Draft Guidance: Tobacco Health Document Subrnigsion,

Please note, there are several icons within the application to help guide you. Most itnportantly, the lisht bulbs indicate additional instructions,
definitions from the guidance document, and other helpful hints,

An agency may not conduct or sponsor, and a person is not required to respond to, a collection of infortnation unless it displays a currently valid
OWB control number. The OB control number for this information collection is 230K (expires 230K

Blue dots indicate required fields.

-I iﬂTobacco-Mi...
| == s st |

n @ iGoogle - Ma...
| S S || e |

| = Fw: website.. P_1_-JRE:W.=J:site... [" 100% p' T | Ol Bo'ss' mM[E2 % ss3em




)

BETX]

File Edit View Designer Output Tools Help

RO B0O 6 O @

ERZAEENES L i )

Template Name: Tobacco Health Document Submission
File Hame: TOBACCO_INTRC_90454 xml

\ersion: 1.0
Last Modified: 12/22/2009 05:46:13 PM

Outline

Screen: Instructions

@ Health Document Submission

1 Owerview
| Instructions
2] Identification
] Submission Content
I Instructions
2 Imparter |dentification
7 Manufacturer Identification

Ih.

Introduction > Submitter Identification > Health Documents > Confirmation
You are in the Introduction section. In this section YaL will be asked to identify WOur rale and type of submission (new ar update ta
previous submission).

Based on your answers to this section, the application will tailor subsequent questions to ensure that you only answer those guestions
relevant to wou.

Instructions and helpdesk assistance (esubmitter@fda.hhs.gov or 1-877-FDA-1CTP (1-877-332-1287)) are available to help
you create your eSubmitter submissions for the Center for Tobacco Products.
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@ Health Document Submission

o Ovarvicw : Statutory Requirements
| Instructions :
2] Ientification :
] Subrmission Caontent || Section 204{a)4) of the act requires each tobacco product manufacturer or inporter, or agent thereof, to submit all documents developed after June
__J Instructions 22, 2009 "that relate to health, toxicological, behawioral, or physiologic effects of current or future tobacco products, their constituents (including
2 Imparter |dentification stnoke constituents), ingredients, cotnponents, and additives."

7 Manufacturer Identification

Please note; For tobacco products that are or will be imported, the required health documents are to be subrmtted by either the forelgn manufacturer
or the importer. [dentify whether the submitter is the manufacturer or the inporter.

For information regarding the section 904 requirements, please refer to the Drafl Guidance: Tobacco Health Document Subrnizsion.

Flease identify your rale: @ \J ) Importer
(! Tobacco Product Manufacturer
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Submission Status

=elect the appropriate subtnission status below for a new subrmizsion of tobacco health documents. If you have no documents to subrot at this time,
wou may indicate this by choosing one of the two statements below.

For information regarding the section 904 requirements, please refer to the Draft Guidance: Tobacco Health Document Subrnission,

Selectthe appropriate submission status: @ | ) New Submission of Tobacco Health Documents

(! No Tobacco Health Documents to Submit

* | | do not have any docurnents that relate to health, toxicological, behavioral, or physiologic effects of current or future tobacco products,
their constituents (including smoke constituents), ingredients, components, and additives to submit for this guarter.

* | | do not anticipate having any such documents in the future. If at anvtime in the future | do have such documents | will immediately notify
FOA and hegin submitting the documents as required by section 8044a)(4) of the Federal Food, Drug, and Cosmetic Act.
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Introduction > Submitter ldentification > Health Documents > Confirmation

Yau are in the Submitter ldentification section. This section requests contact and address information for the respansible individual
submitting the Health Document submission,
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| Instructions
| Tobacco Health Documents
] Tobacco Health Documents Glossary

0 Ifyou are submitting as an importer, you must complete a separate submission for each manufacturer whose products you import. Far each
submission, you are also to identify the manufacturer whose documents yvou are submitting.

Please provide the importer's contact information below:

- |

Contact

Title hir., Ws., Dr.;

FirstiGiven Mame:

tiddle Mame:

Last Mame:

Position Title:

Email Address:

Address

Campany Mame:

Country:

(® United States of America () Other (select below)

Address - Line 1:

Address - Line 2:

City:

State, Province, or Territory:

Post Office or Zip Code:

Phone Numbers

Telephane number:

v - Bt |

Fax numher:

[ |

Reference Numbers {for the Company Name specified above)

DE&B D-L-N-5 Mumber:
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@ Health Document Submission | () Confirmation |

| Overview
| Instructions
] Identification
] Submission Content
_J Instructions
2 Imparter [dentification
7 Manufacturer Identification
| Instructions
| Tobacco Health Documents
] Tobacco Health Documents Glossary

0 Ifyou are submitting as an importer, you must complete a separate submission for each manufacturer whose products you import. Far each
submission, you are also to identify the manufacturer whose documents yvou are submitting.

Please provide the manufacturer's contact information below:

Contact

Title hir., Ws., Dr.;

FirstiGiven Mame:

tiddle Mame:

Last Mame:

Position Title:

Email Address:

Address

Campany Mame:

Country:

(® United States of America () Other (select below)

Address - Line 1:

Address - Line 2:

City:

State, Province, or Territory:

Post Office or Zip Code:

Phone Numbers

Telephane number:

v - Bt

Fax numher:

[

Reference Numbers {for the Company Name specified above)
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@ Health Document Submission i J Confirmation |

] Overview i
) Instructions Introduction > Submitter Identification > Health Documents > Confirmation

| ldentification =

] Submission Content ;
) Instructions || *ou are in the Health Documents section. In this section, you will attach your documents and provide applicable metadata for each

] Irmporter [dentification || submitted document

7 Manufacturer dentification :
| Instructions

—J| Tobacco Health Documents

] Tobacco Health Documents Glossary
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Tobacco Health Documents o

List | Dpetail @

| B Add =

How to Enter Your Health Documentsis):
You may enter data directly into this screen using the data entry method. As an alternative to data entry, you may enter this
information into a pre-formatted spreadsheet that CTP has specifically designed to be imported here.

Data Entry Method:

1. To begin, click on the "Add" button to enter information about a tobacco health document.
2. Once you have entered all of the information for a document, click "Add"to enter information on another
document. If you do not need to add another document, you can continue to the next section.

Import Method:

1. Click an the link (Import Spreadsheet Template for Health Documents) ta launch the pre-formatted Excel
spreadsheet.

2. Save the Excel spreadsheet file to an alternate location on your computer prior to filling in the requested
infarmation. You will need to navigate to the location of the file during the import process.

3. Mote: Avoid changing the format of the spreadsheet as this may interfere with importing and the validation of the

data.
4. Populate the spreadsheet as instructed. For the file attachement question, please provide the file path of the
document in the appropriate cell of the spreadsheet.

5. Once you have entered the information into the spreadsheet, click the Import Data button on the top right corner

of this screen next to the yellow light bulb and follow the import wizard.

. After all data is imported, wou can click on the "List" button to view and verify the imported product(s) information.

Flease note: You may enter a file path in the spreadsheet above as an alternative to attaching each file manually after

importing. In the appropriate cell, go to Insert > Hyperlink and browse to the desired file. Then click okay. You must

ensure that the full file path is displayed in the cell. Click on the [nstructions to view further detail on setting your Microsoft

Excel properties to ensure a full file path.

To see these instructions again, you may click on the "Infoe™ button.
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] Overview
1 Instructions
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~2l) Tobacco Health Documents
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2 Imparter |dentification
7] Manufacturer Identification
I Instructions
~2l) Tobacco Health Documents
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Tobacco Health Documents g ‘ d; ‘
| B Add | == Delete | Delete All | | List Info || @ 3
DOCUMENT IDENTIFICATION
Attach the tobacco health document. ‘
File | @ | = | @ ) “ |
Indicate the following effects that this docurnent relates to; @ | [ Health

[_] Toxicological
|_] Behavioral
|_| Physiologic

Ifthis document references specific current ar future tobacco product{s), vou are required to enter the name of all such products helow.

| E'\} | S = u 3 0 of100 items in the list

-

-

Ifthis document references a class of current or future tobacco products {e.q., menthol cigarettes), vou are required to enter the name of all such
classes helow.

== @ 3 0 of100 iterms in the list

EXR

-

Ifthis document references specific ingredient(s), constituentis), companentts), or additive(s), you are required to enterthe name of all such
ingredient(s), constituentts), component(s), or additive(s) below.

EXREYE YR

0of 100 items in the list

-

-

Ifthis document references a class of ingredients, constituents, components, or additives {e.g., tohacco specific nitrosamines), you are required to enter
the name of all such clagses helow.

| S =) @/ 3

0 of100 iterms in the list

a

|¥

-




7] Importer [dentification :

(2] Manufacturer |dentification DOCUMENT METADATA
7 Instructions :

7)) Tabacco Health Docurnents

] Tobacco Health Documents Glassary

Enter the docurnent title ar iderification number: | |

Frovide the date of creation: ) |

Enter the beginning and ending Bates numbers ofthe attached document: | |

If the document references other documents (e.g., an attachment to an e-mail) enter the relevant Bates number ranges of the referenced document:

S = i 3 0 07 50 iterms in the list

Pravide the author(s) of the document:
[ ] ] G =] i 3 007100 iterns in the list
Pravide the recipient(s) of the dacument:
[ o ] Y = '3 3 0 of 988 iterms in the list
Prowide the custodian of the document: ||

DOCUMENT READABILITY AND ACCESSIBILITY

Enter all relevant keywords (e.g., National Library of Medicing's Medical Subject Headings).

S = i 3 0 of 100 iterms in the list

-

-
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Aftach any explanation or alassary for abhreviations, jargon or code names commonly used.

(=]

EXE

2

0 iterns in the list

Title

Mame | Date

Size

[«

Cetails

[»]
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) Health Document Submission @ Confirmation |

_J Instructions|

2] Confirmation Staternent Introduction > Submitter Identification > Health Documents > Confirmation

) Package Files for Submission

Y¥au are now in the Confirmation section. This section contains a confirmation statement, and requests additional contact and address
information, as needed. Your last step in this section is to package your submission for transmission to the Center for Tobacco
Products.

The packaging process will validate that you have completed data entry.
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'E Warning: Awillfully false statement is a criminal offense, LS. Caode, title 18, section 1001,

The data and information in this submission have been reviewed and, to the best of my knowledoe are cettified to he true and accurate. |
agree to report changes to this information as required under Section 304 of the Act.

[[] Agree

Identify the person submitting this form:

® |

* | If authorized Agent, enter your name and address.

Title (Mr., M=, Dr.J:

FirstiGiven Mame:

Middle Mame:

Last Mame:

Pasition Title:

Email Address:

Compahy Mame:

Country:

Address - Line 1:

Address - Line 2:

City:

State, Pravince, or Territary:

Post Office of Zip Code:

Telephone number:

Fax number:
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'J Health Document Submission

@ confirmation |

| Instructions
#] Confirmation Staternent
| Package Files for Submission

@ You have reached the end of this submission. You may now package the submission and transmititto CTP via the ESG or on CD-ROM in arder to fulfill
your requirements. Submission via the Electronic Submission Gateway provides secure transmission and enables the FDA to provide you with an
automated acknowledgement of receipt.

Atthis time, you may save and cloge this submission to return to it at a later time. To do so, simply click Save and then Close fram the File Menu ortop
Tool Bar. To re-apen this submission after closing, select Cpen Existing Submission from the Intro Screen or Open from the File Menu.

Ifwou would like to package this submission at this time in preparation for transmitting to FOA, please hegin the packaging process by selecting Output
= Package Files for Submission or by clicking the Package icon from the top toolbar, If any required data is missing, the packaging process will not
hegin and a Missing Data Report will he displayed. Flease ensure that all required questions are completed and all applicakhle documents have been
attached within the submission. Specific directions for packaging your submission can he found in the eSubmitter User Manual andfor Quick Guide,

It wou would like to prepare another submission to fulfill other FDA requirements, please select"Mew” fram the File Menu to begin compiling a new
submission and he sure to select the appropriate submission type.
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